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Acerca de Revit 
 
Revit es un software desarrollado por Autodesk que permite crear modelos 3D inteligentes, los cuales 
contienen información tanto geométrica como datos relevantes para todas las fases del ciclo de vida de un 
proyecto: desde el diseño conceptual hasta la construcción y el mantenimiento. Este enfoque integral facilita 
la coordinación entre arquitectos, ingenieros, diseñadores y constructores, mejorando la precisión del 
diseño, reduciendo errores y optimizando los tiempos de entrega. 

Conceptos BIM 
 

Building Information Modeling (BIM) 
 
BIM (Building Information Modeling) es una metodología de trabajo colaborativa que se basa en la creación y 
uso de modelos digitales inteligentes para diseñar, construir y operar edificaciones e infraestructuras. BIM 
integra datos detallados sobre cada componente del proyecto, permitiendo una gestión más eficiente a lo 
largo de todo su ciclo de vida. 
 
El uso de BIM ofrece múltiples ventajas en el desarrollo de proyectos, entre las que destacan la mejora en la 
coordinación en tiempo real entre los distintos profesionales involucrados, la reducción de conflictos e 
interferencias durante la obra, una planificación más precisa, así como un mayor control de costos y tiempos. 
Además, BIM permite tomar decisiones basadas en datos reales del proyecto y proporciona información 
valiosa para la gestión, operación y mantenimiento del edificio una vez finalizada la construcción. 
 

Asociatividad Bidireccional 
 
La asociatividad bidireccional es una de las características clave que define a Revit como una herramienta de 
modelado de información de construcción (BIM). Este concepto hace referencia a la capacidad del software 
para establecer relaciones entre los elementos del modelo, de tal manera que cualquier cambio realizado en 
un componente afecta automáticamente a otros elementos relacionados, y viceversa. Por ejemplo, si se 
modifica la dimensión de una pared, los elementos como ventanas, puertas, plafones, etcétera se 
actualizarán automáticamente para reflejar dicho cambio. Esto asegura la coherencia y precisión del modelo 
a lo largo de todo el proyecto. 
 

Parametría 
 
La parametría es uno de los fundamentos más importantes de Revit y del modelado de información de 
construcción (BIM). Se refiere a la capacidad de controlar las dimensiones, propiedades y relaciones de los 
elementos del modelo a través de parámetros, los cuales pueden ser ajustados para definir, modificar y 
controlar la geometría y comportamiento de los elementos. 
 
La parametría es esencial porque permite un control preciso y flexible de los elementos del modelo, lo que 
facilita la gestión del diseño y la documentación de manera más eficiente. Al trabajar con parámetros, 
cualquier cambio realizado se propaga automáticamente a través del proyecto, ahorrando tiempo y 
minimizando errores. Además, ofrece una alta capacidad de personalización, permitiendo que los elementos 
se adapten a las necesidades específicas de cada proyecto. 
 
 



 

 

Sistemas de clasificación 
 
Los sistemas de clasificación son un conjunto de normas o reglas que agrupan los objetos del modelo según 
características específicas (tipo, función, material, etcétera). Esto permite que los elementos sean 
identificados, organizados y clasificados de acuerdo con categorías predefinidas, lo cual contribuye a la 
estandarización, organización y gestión de los datos, facilitando la creación de reportes y documentación del 
proyecto. Además, los sistemas de clasificación promueven la interoperabilidad, ya que simplifican el 
intercambio de información entre distintas plataformas y disciplinas, garantizando que todos los 
involucrados en el proyecto comprendan y utilicen los mismos datos sin confusiones. 
 
Revit utiliza, por defecto, el sistema OmniClass para organizar jerárquicamente los elementos del modelo, 
aunque también permite al usuario ajustar el sistema de clasificación según las necesidades del proyecto 
mediante parámetros. 

 

                  
 
 

 
 
 
 
 
 
 
 

                  
 
 



 

 

Interfaz de usuario 
 
Revit cuenta con un entorno de trabajo unificado que integra herramientas para arquitectura, estructuras, 
instalaciones MEP y otras disciplinas. Su diseño está pensado para facilitar el acceso a las funciones más 
utilizadas y permitir un flujo de trabajo eficiente en cada etapa del proyecto. 
 
A continuación, se describen los principales componentes de la interfaz que todo usuario debe conocer para 
comenzar a trabajar de manera efectiva. 
 

 
 
 
 
 
 
 
 



 

 

1. Inicio de Revit / Home 
La página de inicio de Revit se muestra al iniciar el software. Es útil para acceder y administrar información 
relacionada con los modelos (archivos o familias recientes, modelos almacenados localmente o en la nube). 
 

 
 

2. Pestaña Archivo 
Permite acceder a acciones habituales de archivo como Nuevo, Abrir y Guardar. También ofrece 
herramientas más avanzadas para administrar los archivos, como Exportar y Publicar. 
 

 
 

3. Barra de herramientas de acceso rápido 
Permite acceder rápidamente a comandos frecuentes como Guardar, Deshacer, Rehacer y Nuevo. Es 
personalizable para incluir herramientas de uso común. 
 

 
 
 

 



 

 

4. Centro de información 
Ofrece acceso a recursos de ayuda, soporte técnico y actualizaciones del producto, integrando herramientas 
como la búsqueda y el acceso a la documentación en línea. 
 

 
 

5. Barra de opciones 
Situada debajo de la cinta de opciones, muestra herramientas contextuales que varían según la herramienta 
o elemento seleccionado, ofreciendo opciones específicas para cada acción. 
 

 
 

6. Selector de tipos 
Ubicado en la paleta de propiedades, permite cambiar el tipo de familia del elemento seleccionado, 
facilitando la modificación de sus características. 
 

 
 

7. Paleta de propiedades 
Muestra las propiedades del elemento seleccionado o de la vista activa. Permite modificar parámetros 
específicos de los elementos del modelo. 
 
Para activar la paleta de propiedades: 

1. Hacer clic en la Pestaña View > Panel Windows > Herramienta User Interface > Opción Properties. 
 



 

 

 
 

8. Navegador de proyectos 
Muestra una jerarquía estructurada del proyecto, incluyendo vistas, planos, tablas de cuantificación y grupos. 
Facilita la navegación y organización del proyecto. 
 
Para activar el navegador de proyectos: 

1. Hacer clic en la Pestaña View > Panel Windows > Herramienta User Interface > Opción Project 
Browser. 

 

 
 

 
 



 

 

9. Barra de estado 
Proporciona información sobre el estado actual del programa, incluyendo el nombre del archivo, la vista 
activa y mensajes de advertencia o información. 
 

 
 

10. Barra de controles de vista 
Permite ajustar la visualización de la vista activa, incluyendo escala, estilo visual y nivel de detalle, facilitando 
la navegación y revisión del modelo. 
 

 
 

11. Área de dibujo 
Espacio principal donde se visualizan y editan las vistas del modelo. Soporta múltiples vistas simultáneas y 
permite interacciones directas con los elementos del proyecto. 
 

 
 

12. Cinta de opciones 
La cinta se muestra al crear o abrir un archivo. Ofrece todas las herramientas necesarias para crear un 
proyecto o una familia. 
 

 
 

13. Pestañas en la cinta de opciones 
Son las pestañas que contienen los comandos o iconos agrupados por función. 
 

 
 
 
 



 

 

14. Pestañas contextuales en la cinta de opciones 
Al usar ciertas herramientas o seleccionar elementos, el software activa una pestaña contextual que muestra 
las herramientas relacionadas con esa herramienta o elemento. La pestaña se cierra al salir de la herramienta 
o al borrar la selección. 
 

 
 

15. Herramientas en la pestaña actual de la cinta de opciones 
Son los comandos y funciones agrupados por su propósito y una función según la disciplina o etapa del 
proyecto. 
 

 
 

16. Paneles en la cinta de opciones 
Organiza las herramientas según su propósito o función para facilitar el trabajo dentro de una disciplina. 
 

 

Tipos de formato de archivos en Revit 
 
Los archivos nativos de Revit son formatos propios desarrollados para gestionar proyectos, plantillas y 
componentes. 
 

• Revit Project File (.RVT) 
Es el formato principal de Revit y constituye el núcleo del modelo BIM. Es el archivo que se utiliza para 
desarrollar el diseño, coordinar disciplinas y generar la documentación. A medida que el proyecto avanza, el 
archivo RVT evoluciona incorporando mayor nivel de detalle y contenido. 
 

• Revit Family File (.RFA) 
Se utiliza para crear y gestionar componentes paramétricos que pueden ser cargados dentro de un archivo 
de proyecto. Estas familias pueden representar elementos arquitectónicos, estructurales o MEP. 
 

• Revit Template File (.RTE) 
Corresponde a una plantilla de proyecto. Este tipo de archivo permite iniciar nuevos proyectos con una base 
preconfigurada, lo que estandariza procesos y mejora la eficiencia del equipo. Un archivo RTE puede 
contener estilos de vista, unidades de medida, tipos de familias precargadas, parámetros compartidos, tablas 
de cuantificación, niveles, ejes y estilos de documentación. Usar plantillas bien desarrolladas permite 
mantener coherencia entre diferentes proyectos de una misma empresa, facilitando también la 
incorporación de nuevos colaboradores al flujo de trabajo. 
 
 
 
 



 

 

• Revit Family Template File (.RFT) 
Se utiliza para la creación de nuevas familias. Estas plantillas determinan el comportamiento inicial del 
componente que se va a crear. Revit ofrece diferentes tipos de plantillas de familia según el objeto a diseñar. 
Elegir la plantilla adecuada es esencial para que la familia tenga el comportamiento esperado dentro del 
modelo, especialmente en lo que respecta a la orientación, restricciones de ubicación, niveles de detalle y 
visibilidad. 

Tipos de elemento en Revit 
 
En Revit, los elementos que componen un modelo se agrupan en tres categorías principales: 
 

• Elementos de modelo 
Son los elementos tridimensionales que representan la construcción física del edificio. Estos elementos 
forman parte del entorno del modelo y se visualizan en vistas 3D, cortes, fachadas y planos. Permiten 
construir digitalmente el edificio, facilitando la coordinación entre disciplinas y la detección de interferencias. 
Ejemplo: muros, puertas, ventanas, columnas, techos, pisos, escaleras, mobiliario, estructura metálica o de 
concreto, etcétera.  
 

• Elementos de referencia (Datum) 
Son elementos que establecen referencias y ayudan a organizar y controlar el modelo. Aunque no se 
construyen físicamente, son esenciales para el posicionamiento y coordinación de elementos. Sirven como 
base para alinear, ubicar y construir otros elementos del modelo con precisión. Ejemplo: niveles, ejes, planos 
de referencia, líneas de modelo y planos de trabajo. 
 

• Elementos específicos de vista 
Son elementos bidimensionales que se colocan en vistas específicas (plantas, cortes, elevaciones) y no 
afectan el modelo 3D. Su función es documentar, etiquetar y comunicar información del diseño. Son 
fundamentales para la elaboración de planos constructivos y la presentación gráfica del proyecto. Ejemplo: 
cotas, textos, etiquetas, símbolos, líneas de detalle, etcétera. 
 

 
 
 



 

 

Tipos de familia en Revit 
 
En Revit, las familias son la base de todos los elementos del modelo. Cada componente que se coloca en un 
proyecto (una puerta, una lámpara, un muro, etc.) pertenece a una familia. Estas familias definen la 
geometría, comportamiento, y parametrización de los elementos. 
 
Revit clasifica las familias en tres tipos principales: 
 

• Familias de sistema 
Son familias integradas directamente en Revit, utilizadas para definir la estructura básica del edifico o crear 
elementos básicos de un sistema. Se editan dentro del proyecto y no pueden ser creadas ni editadas en 
archivos independientes. Ejemplo: muros, pisos, techos, cubiertas, tuberías, ductos y charolas eléctricas. 
 

                                                
 

• Familias cargables 
Son familias creadas o modificadas fuera del proyecto, ajustadas a normas o necesidades específicas del 
modelo. Se almacenan en archivos independientes y pueden ser cargadas en múltiples proyectos. Ejemplo: 
puertas, ventanas, mobiliario, luminarias, equipos MEP, etcétera. 
 

                                             
 

• Familias in situ 
Son familias únicas, modeladas directamente dentro del proyecto para resolver situaciones especiales que no 
se repiten, como geometrías complejas o adaptaciones personalizadas que no se ajustan a una familia típica. 
Ejemplo: esculturas o elementos decorativos únicos, mobiliario a medida para una habitación específica, 
volúmenes arquitectónicos complejos. 
 

 
 
 
 



 

 

Niveles y Vistas 
 
En Revit, los niveles son planos de referencia horizontales que representan diferentes alturas dentro del 
proyecto. Funcionan como base para organizar y estructurar el modelo tridimensional, y son fundamentales 
para definir la ubicación de elementos arquitectónicos, estructurales y MEP.  
 
Un aspecto importante es que, al crear un nuevo nivel, Revit puede generar automáticamente las vistas 
correspondientes o asociadas (Floor Plan, Reflected Ceiling Plan, Structural Plan), dependiendo de la 
configuración del proyecto o las preferencias del usuario, por lo que crearlos correctamente desde el inicio es 
esencial para una gestión ordenada del proyecto. Esto ahorra tiempo y asegura que cada nivel tenga una 
representación gráfica adecuada. En caso contrario, también se pueden crear vistas manualmente vinculadas 
a los niveles existentes. 
 

 
 

Vistas de planta 
 
Las vistas de planta en Revit son representaciones horizontales del modelo, vistas desde arriba, asociadas 
directamente a un nivel específico. Estas vistas permiten modelar y documentar elementos arquitectónicos, 
estructurales y MEP desde una perspectiva clara y organizada. Las vistas de planta son interactivas y 
bidireccionales: cualquier cambio realizado en la vista se refleja automáticamente en el modelo 3D y en otras 
vistas relacionadas. 
 
Además de las plantas de piso, existen otros tipos de vistas horizontales como las plantas de techo reflejado, 
utilizadas especialmente para modelar luminarias o plafones. También se pueden crear vistas de plantas 
estructurales, con configuraciones adaptadas para elementos como vigas, columnas y losas. Cada vista de 
planta puede tener su propia configuración gráfica, como estilos de línea, grosores, visibilidad de categorías y 
filtros, lo que permite adaptar la representación según la disciplina y el propósito del plano. 
 



 

 

 
 

Para crear una vista de planta: 
1. Hacer clic en la Pestaña View > Panel Create > Herramienta Plan Views. 
2. En el menú desplegable, seleccionar el tipo de planta que se desea crear. 

 

 
 

3. Seleccionar el nivel de referencia para la vista. 
4. Hacer clic en el botón OK para crear la vista. Revit abrirá automáticamente la vista creada. 

 

 
 



 

 

Vistas de corte 
 
Las vistas de corte permiten representar el interior del modelo arquitectónico o estructural a través de una 
sección vertical. Estas vistas se utilizan principalmente para mostrar la relación entre pisos, alturas de muros, 
conexiones estructurales y detalles constructivos que no pueden apreciarse en una planta. Las vistas de corte 
son esenciales para la documentación técnica y para comunicar con precisión aspectos constructivos del 
diseño. 
 
Para crear, ajustar y acceder a una vista de corte: 

1. Hacer clic en la Pestaña View > Panel Create > Herramienta Section. 
2. En el área de dibujo, trazar la línea de corte especificando los puntos de inicio y fin. 
3. Hacer clic sobre la marca Flip Section para especificar la dirección del corte. 
4. Hacer clic sobre las guías de la línea de corte para definir la profundidad y longitud del corte. 

 

 
 

5. Hacer doble clic sobre el símbolo del corte para acceder directamente a la vista. 
 

 
 

Vistas 3D 
 
Las vistas 3D ofrecen una representación tridimensional del modelo, lo cual facilita la comprensión espacial 
del proyecto y permite una mejor coordinación entre disciplinas. Estas vistas son útiles para presentar 
avances al cliente, hacer recorridos virtuales y detectar interferencias en modelos colaborativos. 
 
Para crear una vista 3D: 

1. Hacer clic en la Pestaña View > Panel Create > Herramienta 3D View. Revit abrirá automáticamente la 
vista creada en perspectiva isométrica. 



 

 

 
 

Propiedades de una vista 
 
En Revit, cada vista posee una serie de propiedades que definen como se representa el modelo en la 
documentación, visualización o presentación del proyecto. 
 
A continuación, se muestran algunas de las propiedades de una vista: 
 

• View Name: permite identificar el nombre de la vista y puede personalizarse para reflejar su 
contenido o propósito, por ejemplo "Planta Arquitectónica – Nivel 1", lo que facilita el orden y la 
comprensión del conjunto de planos. 

• View Scale: define a que proporción se representan los elementos del modelo en la vista. Esta escala 
influye directamente en el tamaño de las cotas, etiquetas, símbolos y detalles gráficos. 

• Detail Level: controla la cantidad de información visual que se muestra en pantalla. Puede 
configurarse en Coarse, Medium o Fine. Un nivel Coarse muestra representaciones simplificadas, 
como líneas básicas para muros, mientras que un nivel Fine puede incluir capas, patrones de relleno 
y detalles constructivos. Esta propiedad es clave cuando se quiere ajustar el nivel de complejidad 
gráfica en función del tipo de plano o presentación que se necesita. 

 

 
 

• Visual Style: permite definir la forma en que se visualiza la geometría en pantalla. Existen distintos 
modos como Wireframe, Hidden Line, Shaded, o Realistic. Estos estilos pueden emplearse tanto para 
la edición técnica como para presentaciones más visuales y comprensibles para el cliente. 

 



 

 

                          
 

                 
 

• View Range: también conocido como rango de corte. Este parámetro establece desde que altura 
hacia arriba y hacia abajo se visualiza el modelo dentro de la vista horizontal. Está compuesto por 
planos como la línea de corte, el plano superior, inferior y la profundidad de vista. 

 

 
 

• Discipline: clasifica el propósito de la vista según la disciplina (arquitectura, estructura, mecánica, 
etcétera. Esta clasificación afecta los elementos que se visualizan por defecto y permite establecer 
configuraciones gráficas específicas para cada especialidad, facilitando el trabajo en proyectos 
multidisciplinarios. 

• View Template: las plantillas son conjuntos predefinidos de configuraciones aplicables a una o más 
vistas. Estas plantillas estandarizan aspectos como la escala, el nivel de detalle, los filtros de 
visibilidad, entre otros. Son muy útiles para mantener coherencia visual y gráfica en los planos del 
proyecto. 

 



 

 

 
 

• Phase, Phase Filter: permiten organizar el proyecto en etapas constructivas, tales como existente, 
demolición o nuevo. Esta funcionalidad es vital cuando se trabaja en ampliaciones o remodelaciones, 
ya que permite mostrar los elementos correspondientes a cada fase con estilos gráficos 
diferenciados. 

• Visibility/Graphics Overrides: permite modificar las opciones de visibilidad gráfica, donde el usuario 
tiene control total sobre que categorías de elementos se muestran o se ocultan en la vista. Además, 
se pueden aplicar filtros personalizados por materiales, fases, tipos de familia, etc., lo cual brinda una 
herramienta poderosa para el control visual del proyecto. 

 

 
 
Para acceder a las propiedades de una vista: 

1. En el navegador del proyecto, hacer clic sobre la vista deseada. 
2. Con la vista activa, dirigirse al Panel de Propiedades para visualizar o modificar la información 

asociada a la propiedad de la vista. 
 



 

 

 
 

Navegación en vistas 
 
En Revit, la navegación eficiente entre las diferentes vistas del modelo es esencial para un flujo de trabajo 
productivo y preciso. Las vistas permiten visualizar y editar el modelo desde distintas perspectivas: planta, 
cortes y vistas 3D. 
 
A continuación, se detallan las herramientas de navegación disponibles en una vista: 
 

• Zoom: permite acercarse o alejarse del modelo al girar la rueda del mouse (hacia adelante para 
acercar, hacia atrás para alejar). 

 

                                 
 
 
 
 
 
 
 
 
 
 



 

 

• Pan (Paneo): al mantener presionada la rueda del mouse y arrastrar la vista en cualquier dirección, 
esta se desplaza en el plano sin rotarla ni cambiar el nivel de zoom. 

 

 
 

• Orbit: permite visualizar vistas 3D desde distintos ángulos al mantener presionadas las teclas Shift + 
rueda del mouse + mover el mouse. 

 

 
 

• ViewCube (Cubo de Vistas): esta herramienta interactiva permite explorar vistas 3D al hacer clic en 
las caras, aristas o esquinas del cubo para cambiar rápidamente la orientación del modelo. 

 

 
 
 
 
 
 
 
 
 
 
 



 

 

• Steering Wheel (Rueda de Navegación): es una herramienta flotante que agrupa varias funciones de 
navegación en un solo control circular, útil especialmente en vistas 3D. 

 

 

Selección de objetos 
 
La selección de objetos en Revit es una habilidad fundamental para trabajar con precisión y eficiencia en un 
modelo.  
 
A continuación, se muestran los métodos principales para seleccionar elementos: 
 

• Selección individual 
1. En el área de dibujo, hacer clic directamente sobre un objeto para seleccionarlo.  
2. Para cancelar la selección, presionar Esc en el teclado. 

 

 
 

• Selección múltiple por cursor 
1. En el área de dibujo, hacer clic directamente sobre un objeto para seleccionarlo. 
2. Presionar Ctrl + clic para agregar otros objetos a la selección. 
3. Presionar Shift + clic para descartar objetos de la selección. 
4. Para cancelar la selección, presionar Esc en el teclado. 

 



 

 

 
 

• Selección múltiple por ventana 

1. En el área de dibujo, hacer clic para proyectar una ventana: 
a. De izquierda a derecha (selección inclusiva): selecciona solo los elementos que están 

completamente dentro de la ventana. 
 

 
 

b. De derecha a izquierda (selección cruzada): selecciona cualquier elemento que esté 
dentro o parcialmente dentro de la ventana. 

 

 
 

2. Para cancelar la selección, presionar Esc en el teclado. 
 
 
 

 



 

 

Filtros de selección 
 
Si dentro de una selección existen elementos de diversas categorías, es posible aplicar un filtro para 
descartar categorías no deseadas. Por ejemplo, si en una selección hay muros, puertas, ventanas y 
mobiliario, se puede aplicar el filtro para omitir el mobiliario. 
 
Para aplicar un filtro de selección: 

1. Con múltiples objetos seleccionados en el área de dibujo, hacer clic en la Pestaña contextual 
Modify|Multi-Select > Panel Selection > Herramienta Filter. 

2. En el cuadro de diálogo Filter, activar o desactivar las categorías según lo deseado para la selección. 
 

 
 

3. Hacer clic en el botón OK para confirmar la configuración del filtro y aplicarlo a la selección. 
 

 

Propiedades de tipo e instancia de los objetos en Revit 
 
En Revit, cada elemento del modelo posee dos tipos de propiedades: de tipo y de instancia. Estas 
propiedades controlan desde aspectos geométricos hasta parámetros de información del modelo BIM. 
 

• Propiedades de instancia 
Las propiedades de instancia permiten personalizar cada componente de forma individual, lo cual es ideal 
para objetos que necesitan un tratamiento único dentro del modelo. Modificar una propiedad de instancia 
afecta únicamente al objeto seleccionado sin alterar a los demás elementos del mismo tipo. 
 

 
 



 

 

Para acceder y modificar las propiedades de instancia de un objeto: 
1. En el área de dibujo, seleccionar el objeto deseado. 
2. Dirigirse al Panel de Propiedades para visualizar las propiedades de instancia del elemento. 
3. En caso necesario, modificar los valores de la propiedad directamente en el panel. 
4. Verificar los cambios aplicados al elemento seleccionado. 

 

 
 

• Propiedades de tipo 
Las propiedades de tipo son útiles para mantener consistencia y facilitar cambios globales en los elementos 
del proyecto. Modificar estas propiedades afecta automáticamente a cada ejemplar que pertenezca al mismo 
tipo del objeto seleccionado. 
 
Para acceder y modificar las propiedades de tipo de un objeto: 

1. En el área de dibujo, seleccionar el objeto deseado. 
2. Dirigirse al Panel de Propiedades y hacer clic en el botón Edit Type. 

 

 
 

3. En el cuadro de diálogo Type Properties, visualizar las propiedades de tipo del elemento. 
4. En caso necesario, modificar los valores de la propiedad directamente el cuadro de diálogo y hacer 

clic en OK para confirmar los cambios. 
5. Verificar los cambios aplicados a todos los elementos del mismo tipo. 

 
 
 



 

 

 

Parámetros de los objetos en Revit 
 
En Revit, los parámetros son fundamentales para definir y controlar la información que poseen los elementos 
del modelo. Estos parámetros permiten personalizar comportamientos, propiedades físicas, gráficas y de 
datos de los elementos, haciendo de Revit una herramienta poderosa para el modelado BIM. 
 
Revit permite trabajar con parámetros de diferentes tipos: 
 

• Parámetros de familia 
Son parámetros definidos dentro de una familia de Revit y se utilizan para controlar las propiedades 
específicas de un componente. 
 
Para crear un parámetro de familia: 

1. Abrir o crear una familia en el Editor de familias de Revit. 
2. Hacer clic en la Pestaña Create > Panel Properties > Herramienta Family Types. 
3. En el cuadro de diálogo Family Types, hacer clic en el botón New Parameter. 
4. En el cuadro de diálogo Parameter Properties, seleccionar la opción Family Parameter y configurar: 

a. Nombre del parámetro 
b. Tipo de parámetro 
c. Sección donde se desea agrupar el parámetro 
d. Tipo de propiedad para el objeto 

5. Hacer clic en el botón OK para confirmar la creación del parámetro. 
 



 

 

 
 

• Parámetros compartidos 
Son parámetros definidos en un archivo externo (.txt) que pueden ser usados en múltiples familias y 
proyectos. Permiten coordinar información entre varias familias y dentro del proyecto. 
 
Para crear el archivo de parámetros compartidos: 

1. Abrir o crear una familia en el Editor de familias de Revit. 
2. Hacer clic en la Pestaña Manage > Panel Settings > Herramienta Shared Parameters. 
3. En el cuadro de diálogo Edit Shared Parameters, hacer clic en el botón Create. 
4. Guardar el archivo en una ubicación accesible. 

 

 
 

5. En la sección Groups, hacer clic en New para generar diferentes grupos que permitan clasificar los 
parámetros. 

 



 

 

 
 

6. Desplegar el listado Parameter group, seleccionar el grupo donde se desea almacenar el parámetro y, 
en la sección Parameters, hacer clic en New. 

7. En el cuadro de diálogo Parameter Properties, configurar: 
a. Nombre del parámetro 
b. Tipo de parámetro 

 

 
 

8. Repetir los pasos 6 y 7 según el número de parámetros requeridos. 
9. Hacer clic en el botón OK para finalizar la creación del archivo. 

 
Para agregar un parámetro compartido a una familia: 

1. Abrir o crear una familia en el Editor de familias de Revit. 
2. Hacer clic en la Pestaña Create > Panel Properties > Herramienta Family Types. 
3. En el cuadro de diálogo Family Types, hacer clic en el botón New Parameter. 
4. En el cuadro de diálogo Parameter Properties, seleccionar la opción Shared Parameter y hacer clic en 

el botón Select. 
 



 

 

 
 

5. En el cuadro de diálogo Shared Parameters, seleccionar el parámetro compartido desde el archivo 
creado previamente. 

 

 
 

6. En el cuadro de diálogo Parameter Properties, configurar: 
a. Sección donde se desea agrupar el parámetro 
b. Tipo de propiedad para el objeto 

7. Hacer clic en el botón OK para confirmar. 
 



 

 

 
 

Para agregar un parámetro compartido a un proyecto: 
1. Abrir o crear un proyecto en Revit. 
2. Hacer clic en la Pestaña Manage > Panel Settings > Herramienta Project Parameters. 
3. En el cuadro de diálogo Project Parameters, hacer clic en el botón New Parameter. 
4. En el cuadro de diálogo Parameter Properties, seleccionar la opción Shared Parameter y hacer clic en 

el botón Select. 
 

 
 

5. En el cuadro de diálogo Shared Parameters, seleccionar el parámetro compartido desde el archivo 
creado previamente. 

 



 

 

 
 

6. En el cuadro de diálogo Parameter Properties, configurar: 
a. Sección donde se desea agrupar el parámetro 
b. Tipo de propiedad para el objeto 
c. Categorías donde se aplicará el parámetro 

7. Hacer clic en el botón OK para confirmar. 
 

 

Ubicación del proyecto 
 
Establecer la ubicación geográfica del proyecto en Revit es esencial para garantizar la precisión en la 
orientación y la integración con otros modelos. Esta configuración permite al modelo reflejar su posición real 
en la superficie terrestre, facilitando análisis solares, estudios de sombra y procesos de coordinación. 
 
Para ubicar geográficamente un proyecto: 

1. Abrir o crear un proyecto en Revit. 
2. Hacer clic en la Pestaña Manage > Panel Project Location > Herramienta Location. 
3. En el cuadro de diálogo Location and Site, definir la ciudad o región correspondiente. 
4. Hacer clic en OK para confirmar la ubicación. 



 

 

 

Punto base del proyecto 
 
El punto base del proyecto (Project Base Point) es el origen del sistema de coordenadas del modelo. 
Establecer este punto es crucial para definir la ubicación interna del proyecto y facilitar la coordinación con 
otros modelos vinculados. 
 
Para definir el punto base de un proyecto: 

1. Abrir o crear una vista de planta. 
2. En el Visibility/Graphics Overrides, activar la categoría Site > Project Base Point. 

 

 
 

3. En la vista de planta, hacer clic en el Project Base Point para seleccionarlo. 
4. En el Panel de Propiedades, posicionar el Project Base Point en la ubicación deseada. 

 



 

 

 

Punto de reconocimiento topográfico del proyecto 
 
El punto de reconocimiento topográfico del proyecto (Survey Point) representa una ubicación geográfica real 
en el sitio del proyecto. Establecer este punto es fundamental para alinear el modelo con coordenadas reales 
y facilitar la integración con datos externos. 
 
Para definir el punto de reconocimiento topográfico de un proyecto: 

1. Abrir o crear una vista de planta. 
2. En el Visibility/Graphics Overrides, activar la categoría Site > Survey Point. 

 

  
 

3. En la vista de planta, hacer clic en el Survey Point para seleccionarlo y activar la herramienta Change 
clip state of point. 

4. En el Panel de Propiedades, posicionar el Survey Point en la ubicación deseada y hacer clic 
nuevamente en la herramienta Change clip state of point. 

 



 

 

 

Coordenadas compartidas 
 
Al trabajar con modelos vinculados, es importante alinear sus sistemas de coordenadas para asegurar que 
estén correctamente posicionados dentro del proyecto. Revit permite que un modelo adquiera las 
coordenadas de un proyecto vinculado o que el proyecto sea quien envíe las coordenadas para que el 
modelo vinculado las utilice como referencia. 
 
Para adquirir las coordenadas de un modelo vinculado en un proyecto: 

1. Abrir o crear una vista de planta dentro del proyecto. 
2. Hacer clic en la Pestaña Manage > Panel Project Location > Herramienta Coordinates > Opción 

Acquire Coordinates. 
3. Hacer clic para seleccionar el modelo vinculado del cual se desea adquirir las coordenadas. 

 

 
 
 
 
 
 
 
 



 

 

Para publicar las coordenadas de un proyecto a un modelo vinculado: 
1. Abrir o crear una vista de planta dentro del proyecto. 
2. Hacer clic en la Pestaña Manage > Panel Project Location > Herramienta Coordinates > Opción 

Publish Coordinates. 
3. Hacer clic para seleccionar el modelo vinculado al cual se desea enviar las coordenadas. 
4. En el cuadro de diálogo Location and Site, seleccionar la posición para el modelo vinculado. 
5. Hacer clic en OK para confirmar. 

 

 

Norte del proyecto vs norte real 
 
En Revit, es común trabajar con el norte del proyecto (Project North) para facilitar el diseño en planta. Sin 
embargo, para análisis reales como el comportamiento solar o la coordinación con planos topográficos y 
otros sistemas, es necesario visualizar las vistas con el norte real (True North). Rotar una vista al norte real 
permite al usuario ver la orientación geográfica auténtica del proyecto. 
 
Para orientar una vista en función del norte real: 

1. Abrir o crear una vista de planta dentro del modelo.  
2. En el Panel de Propiedades, hacer clic en Orientation y seleccionar la opción True North. 

 

 



 

 

Trabajo con modelos vinculados 
 
Un proyecto vinculado es un archivo de Revit que se inserta como referencia en otro modelo. Esto permite 
trabajar en entornos colaborativos sin modificar directamente los archivos de los demás. 
 
Para vincular un modelo al proyecto: 

1. Abrir o crear una vista de planta dentro del modelo. 
2. Hacer clic en la Pestaña Insert > Panel Project Link > Herramienta Link Revit. 
3. En el cuadro de diálogo Import/Link RVT, seleccionar el archivo que se desea vincular y definir la 

opción de posicionamiento al vincular: 
a. Auto - Center to Center: alinea los centros geométricos de ambos modelos. 
b. Auto - Internal Origin to Internal Origin: alinea el punto base interno de ambos modelos. 

Esta opción funciona si los modelos se crearon con el mismo origen. 
c. Auto - By Shared Coordinates: alinea los modelos según un sistema de coordenadas 

compartido. 
d. Auto - Project Base Point to Project Base Point: alinea los modelos según el punto base de 

proyecto de ambos modelos. 
e. Manual: permite posicionar y rotar el modelo vínculo después de insertarlo. 

4. Hacer clic en el botón Open. 
 

 
 

Para administrar los modelos vinculados en un proyecto: 
1. Hacer clic en la Pestaña Manage > Panel Manage Project > Herramienta Manage Links. 
2. En el cuadro de diálogo Manage Links, seleccionar el modelo vinculado que se desea manipular y 

hacer clic en el icono de la acción requerida: 
a. Reload: recarga el archivo vinculado si ha sido actualizado externamente para reflejar los 

cambios en el proyecto. 
b. Reload from: recarga el vínculo desde una nueva ubicación. Esta opción es útil cuando el 

archivo vinculado se ha movido a otra carpeta. 



 

 

c. Unload: si un vínculo no es necesario temporalmente, esta opción permite liberarlo de la 
memoria, lo que puede mejorar el rendimiento del proyecto, especialmente en archivos 
grandes. No elimina el vínculo, solo lo descarga temporalmente. 

d. Remove: permite eliminar permanentemente un vínculo del proyecto. Esta acción no es 
reversible sin cargar nuevamente el archivo. 

 

 
 

Para manipular las propiedades de las categorías de un modelo vinculado en un proyecto: 
1. Abrir o crear una vista en el proyecto. 
2. En el Visibility/Graphics Overrides, activar la ficha Revit Links. 
3. En la lista de modelos vinculados, seleccionar el modelo vinculado que se desea manipular y hacer 

clic en el botón de la columna Display Settings. 
 

 
 

4. En el cuadro de diálogo RVT Link Display Settings, seleccionar la opción requerida para controlar la 
visibilidad de las categorías: 

a. By Host View: controla la vista según la configuración de la vista host. 
b. By Linked View: controla la vista según la configuración de la vista de origen. 
c. Custom: para personalizar la vista según características específicas definidas por el usuario. 



 

 

 
 

5. Hacer clic en OK para confirmar la configuración y aplicar los cambios en la vista actual del proyecto. 

Espacios (Rooms) 
 
Revit permite definir y gestionar espacios funcionales dentro del modelo arquitectónico. Esta funcionalidad 
tiene como objetivo identificar, cuantificar y gestionar los distintos espacios que componen un proyecto, 
tanto en la fase de diseño como en etapas posteriores de documentación, análisis y operación. 
 
Para crear y gestionar rooms en un proyecto: 

1. Abrir o crear una vista de planta dentro del proyecto. 
2. Hacer clic en la Pestaña Architecture > Panel Project Room & Area > Herramienta Room. 
3. En la barra de opciones, configurar las características deseadas para el room. 

 

 
 

4. En la Paleta de Propiedades, desplegar el selector de tipos y seleccionar la etiqueta para el room. 
 

 
 

5. En el dibujo, hacer clic para colocar el room en el área deseada. 



 

 

6. Seleccionar el room y, en la Paleta de Propiedades, definir las propiedades necesarias para 
identificarlo. 

 

 

Fases 
 
En Revit, las fases representan momentos distintos en el tiempo del desarrollo de un proyecto, por ejemplo 
“Existente”, “Demolición”, “Nueva Construcción”, entre otras. Esta herramienta es indispensable en 
proyectos de remodelación o donde coexisten elementos existentes y nuevos. 
 
Cada elemento en el modelo puede ser asociado a una fase específica, lo que permite un control preciso de 
la visualización, planificación y documentación en cada etapa del proyecto. Además, las vistas pueden 
configurarse para mostrar información correspondiente a una fase determinada, incluyendo cómo se ven los 
elementos nuevos, demolidos o existentes. 
 
Para crear y gestionar fases en un proyecto: 

1. Hacer clic en la Pestaña Manage > Panel Phasing > Herramienta Phases. 
2. En el cuadro de diálogo Phasing, activar la ficha Project Phases para crear, renombrar y modificar el 

orden de las fases según las necesidades del proyecto. 
 

 
 



 

 

3. Ir a la ficha Phase Filters y definir la visualización de los elementos en una vista según su fase. 
 

 
 

4. Ir a la ficha Graphic Overrides y configurar las propiedades gráficas de cada fase. 
 

 
 

5. Hacer clic en OK para confirmar la creación y configuración de las fases del proyecto. 
 
Para asignar fases a los elementos del modelo: 

1. Abrir o crear una vista dentro del modelo. 
2. Seleccionar el objeto al que se le desea asignar la fase. 
3. En la Paleta de Propiedades, definir los valores requeridos para las propiedades: 

a. Phase Created: define la fase de creación del elemento. 
b. Phase Demolished: define la fase en que el elemento será demolido. 

 



 

 

 
 

Para controlar la visualización por fases en una vista: 
1. Abrir o crear una vista dentro del modelo. 
2. En la Paleta de Propiedades, definir los valores requeridos para las propiedades: 

a. Phase: establece a que fase corresponde la vista. 
b. Phase Filter: determina la visualización de los elementos según su estado en esa fase. 

 

 
 
 
 
 
 
 
 



 

 

Listados de cuantificación 

 

Los listados de cuantificación son herramientas fundamentales para extraer información del modelo de 
forma automática y organizada. Los listados pueden ser filtrados por fases, lo que permite generar 
mediciones específicas para etapas de construcción. Si se trabaja con proyectos vinculados, también es 
posible incluir datos de modelos externos en los listados. 
 
Para crear y configurar listados de cuantificación básicos: 

1. Hacer clic en la Pestaña View > Panel Create > Herramienta Schedules > Opción Schedule/Quantities. 
2. En el cuadro de diálogo New Schedule, seleccionar la categoría que se desea cuantificar y asignar un 

nombre al listado. 
3. Hacer clic en OK para confirmar la configuración anterior. 

 

 
 

4. En el cuadro de diálogo Schedule Properties, definir las propiedades de las pestañas: 
a. Fields: permite seleccionar los campos a visualizar en la tabla. 

 



 

 

 
 

b. Filter: aplica filtros para restringir los elementos del listado. 
 

 
 

c. Sorting/Grouping: ordena y agrupa los elementos del listado según los criterios definidos por 
el usuario. 

 



 

 

 
 

d. Formatting: permite personalizar el formato y presentación de las columnas del listado. 
 

 
 

e. Appearance: define el aspecto gráfico del listado. 
 



 

 

 
 

5. Hacer clic en OK para confirmar la creación del listado. 
 

 
 

Para crear y configurar listados de cuantificación por fases: 
1. Hacer clic en la Pestaña View > Panel Create > Herramienta Schedules > Opción Schedule/Quantities. 
2. En el cuadro de diálogo New Schedule, seleccionar la categoría que se desea cuantificar y asignar un 

nombre al listado. 
3. Desplegar el campo Phase y seleccionar la fase requerida. 
4. Hacer clic en OK para confirmar la configuración anterior. 

 



 

 

 
 

5. En el cuadro de diálogo Schedule Properties, definir las propiedades de las pestañas: 
a. Fields: permite seleccionar los campos a visualizar en la tabla. 
b. Filter: aplica filtros para restringir los elementos del listado. 
c. Sorting/Grouping: ordena y agrupa los elementos del listado según los criterios definidos por 

el usuario. 
d. Formatting: permite personalizar el formato y presentación de las columnas del listado. 
e. Appearance: define el aspecto gráfico del listado. 

6. Hacer clic en OK para confirmar la creación del listado. 
 

 
 

Para crear y configurar listados de cuantificación para proyectos vinculados: 
1. Hacer clic en la Pestaña View > Panel Create > Herramienta Schedules > Opción Schedule/Quantities. 
2. En el cuadro de diálogo New Schedule, seleccionar la categoría que se desea cuantificar y asignar un 

nombre al listado. 
 



 

 

 
 

3. En el cuadro de diálogo Schedule Properties, definir las propiedades de las pestañas: 
a. Fields: permite seleccionar los campos a visualizar en la tabla. Para esta tabla, activar la 

opción Include elements in links. 
 

 
 

b. Filter: aplica filtros para restringir los elementos del listado. 
c. Sorting/Grouping: ordena y agrupa los elementos del listado según los criterios definidos por 

el usuario. 
d. Formatting: permite personalizar el formato y presentación de las columnas del listado. 



 

 

e. Appearance: define el aspecto gráfico del listado. 
4. Hacer clic en OK para confirmar la creación del listado. 

 

 

Localización de objetos por ID 
 
En Revit, cada elemento del modelo tiene un ID único. Este ID es asignado automáticamente por el sistema y 
nunca se repite dentro del mismo proyecto. El Element ID permite localizar rápidamente objetos, incluso si 
están ocultos, en un modelo vinculado, o si se desconoce su ubicación exacta. 
 
Para visualizar el ID de un objeto: 

1. En una vista, seleccionar el objeto del cual se desea conocer el ID. 
2. Hacer clic en la Pestaña Manage > Panel Inquiry > Herramienta IDs of Selection. 

 

 
 

Para buscar y seleccionar un objeto por su ID: 
1. Hacer clic en la Pestaña Manage > Panel Inquiry > Herramienta Select by ID. 
2. En el cuadro de diálogo Select Elements by ID, ingresar el valor ID del elemento. 
3. Hacer clic en el botón Show para que Revit muestre y seleccione automáticamente el objeto en el 

modelo. 
 



 

 

 

Limpieza de elementos no utilizados 
 
A medida que un proyecto en Revit evoluciona, es normal que se acumulen elementos no utilizados en el 
modelo. Estos elementos siguen ocupando espacio, lo que puede afectar el rendimiento del equipo, 
aumentar el tamaño del archivo y dificultar la navegación. La herramienta Purge Unused permite eliminar 
definitivamente, y de forma segura, estos elementos del proyecto. 
 
Para purgar elementos no utilizados en un modelo: 

1. Hacer clic en la Pestaña Manage > Panel Settings > Herramienta Purge Unused. 
2. En el cuadro de diálogo Purge Unused, seleccionar los elementos deseados. 
3. Hacer clic en OK para ejecutar el proceso de limpieza.  

 
NOTAS:  

• Revit eliminará automáticamente los elementos seleccionados. 

• El proceso puede tardar unos segundos o minutos dependiendo del tamaño del modelo. 

• Los resultados comunes tras la ejecución del proceso son: 
o Reducción del tamaño del archivo (.RVT) 
o Aumento en la velocidad de ejecución de procesos de apertura y guardado 
o Mejora en la navegación del modelo 

• El proceso de purga no puede deshacerse fácilmente.  

• Es recomendable guardar una copia del modelo antes de purgar, especialmente en etapas críticas del 
proyecto. 

• El proceso solo elimina lo que no está siendo utilizado en absoluto dentro del modelo. 
 



 

 

 


